
Using patterns



Patterns allow us to empower applications by easily adding new features.

When we apply a pattern, GeneXus creates all the necessary objects to provide the desired behavior without the need
for us to program them.

For example, let’s suppose that even though we have the Countries transaction to enter, change and delete countries...
we also want an attractive page to query countries and show all the existing countries, filter by country name, support
paging, etc.
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Pattern Work With for Web
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Also, it should enable us to go to the Countries transaction to add a new country...
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…change an existing country…



Applying Patterns

…or delete it.
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Patterns

for Web

for Smart Devices 

Work With

To quickly implement this, we have a pattern called “Work With” and we will show how to apply it to the Country
transaction.

This pattern is available for web applications, such as the application in the example, or for Smart Device applications.

In the Patterns tab of the Country transaction, we can see both patterns.
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Why are they called patterns?

Instance Pattern

Using patterns saves time

Build screens that invoke each 
other following a certain logic

Why are they called patterns? Because from one instance, in this case from a transaction object, it builds a series of
screens that invoke each other following a certain logic, which for this particular pattern has to do with presenting
information in a hierarchy, where first all the info of the corresponding table is listed and it is possible to work with each
element, either just to show it, or to change it as well.
This is an extremely common pattern of interaction, so not having to implement it manually saves us a lot of time.



Now we will see how to apply the Work With pattern for Web to the Country transaction.

In the Country transaction, we select the “Patterns” section, choose the Work With tab, click on “Apply this pattern on
save” and save.

Now, if we place the Country transaction, we can see that below the transaction there are several objects that were
created by GeneXus when the Work With pattern was applied.

Applying Patterns

How to obtain it

• In the Country transaction:

Automatically generated by GeneXus



DEMO
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[ DEMO: https://youtu.be/XuzVrb6TWDE ]

Now we press F5 to run the application and look at what has been automatically generated just by selecting an option
and saving.

First of all, note that a link is displayed with the text “Work With Country” for us to work with a wider range of features.

We click on this link...

...and see that a page is opened to show all the countries that we have entered.

For each line with a country there are 2 actions available: Edit the details of the country in the line... we see that the
transaction is opened and allows us to change the information related to the selected country. Let's add a city for France
and confirm.

This other action clearly offers us the option to delete the country in the line.

And the ‘INSERT’ action also allows inserting a new country. Running it opens the Countries transaction, ready for us to
add a country and all its related data:

We enter “United States”... and a city, New York... We confirm.

Note that we can search by country name: if we type “F” it shows all the countries that begin with this letter. In this
case, we only have France.

Note that the country name has a link. If we click on it, all the details of the selected country are displayed in the first tab
and another tab labeled City shows the list of cities that belong to this country.

We choose to go back to Work With Countries.



Pattern instance
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We easily applied the Work With pattern to the Country transaction and now we will apply it to the Attraction
transaction.

We go back to GeneXus, open the Attraction transaction, open the “Patterns” section and in the Work With for Web tab
we select the option “Apply this pattern on save”.

Upon saving, all the necessary objects are generated to implement all the features that we’ve seen, in this case, to work
with Attractions.

We confirm that they have been generated, and press F5.

Note that just like in the previous case, we're offered to “work with attractions” and from there the transaction is called.

We run “Work With Attractions”...

Again, we see that if we change the screen size, the information displayed is adjusted. In this case, instead of showing all
the Attraction attributes, only the name is displayed.

Here we have the same query features that we saw for “Work With Countries”... and we will use it to enter more tourist
attractions.

Let's insert the Great Wall... in China... we select the path to the image... and indicate that it is in Beijing.

Now we will add the Eiffel Tower.

We type “Eiffel Tower”… It’s in France… and it is a monument. We select the path to the image... and indicate that the
Eiffel Tower is in Paris.

Now, suppose that we are asked, in addition to filtering by attraction name, to provide the ability to filter the attractions
in a certain country.



Let's see how to add another filter to “Work With Attractions”... Another request is that the grid shouldn't
display the country or city codes... or the category... We go back to GeneXus.

So far, we have only selected “Apply this pattern on save” and we’ve seen all the features that are
automatically generated… what we haven’t seen so far is this tree of configurable values.

Let’s take a quick look at this “Selection” node that also says “Attractions”, because below it are all the
configurable options for the “Work With Attractions” element that will be generated.

For instance, note that here we can see the operations that will be available to update the database, invoking
the transaction to do so.

If you don’t want to offer some of them, you can customize them in the properties window.

Right below is the Attributes node which contains the attributes that will be included in the “work with” grid.



Working with the instance

AFTER

BEFORE

Applying Patterns

Since we were asked not to display the country or city identifier in each line, nor the category, we will remove them.
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[ DEMO: https://youtu.be/5RFOW4Q63ZQ ]

We have also been asked to make it possible to filter all the attractions in a certain country. To do so, under “Filter”, we
right-click on the “Attributes” node, and “Select Attributes…”.

In this selection dialog, we choose CountryName.

We are asked if we want the filter condition to be defined and we select Yes.

This automatic filtering condition is generated over the grid's data, which will add a field outside the grid (it will be a
variable) for the user to enter characters in order to display only the countries that contain them.

We press F5 to see the result of the customizations we’ve made.

We see that the main filter by attraction name continues to be displayed over the grid, as before (also, the grid no
longer displays the country, city and category identifiers). Now a column has been added to the left, which can be
hidden and displayed again, and where all the extra filters added to the pattern will be displayed. In this case, there is
only one: Country Name. If we press "F“, we see that only the attributes of France are displayed.

If we also type “E” in Name the only data item that matches both conditions is the Eiffel Tower.

Note that if we type “E” in the country filter: “E”, there are no records to display that match these conditions.

And if we indicate that the country name starts with a “C” but don’t enter any requirements for the attraction name, the
Great Wall of China is displayed.

Now suppose that we are asked to make it possible to order the data in the grid, whether in alphabetical order by
attraction name as we've been doing so far, or by country name. If we click on the column by which we want to order.

We see that it is already done, and that it even allows us to order in descending order.



That's why we wouldn't have to make any changes to the pattern. However, clicking on the column only orders
the data that had already been loaded to the grid.
In this case, we only have 3 attractions in the database, but if we had 20, not all of them would be displayed. As
we've said, the grid supports paging [go back to the countries ppt with paging shown at the beginning]. This
means that only an X number of records are displayed at once. When the screen is opened, the first X are
displayed, and it is possible to show the next X, and so on.
Therefore, the records displayed on each page will depend on the total ordering. To order all the records
before loading them in the pages, we must do something in the pattern.
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[ DEMO: https://youtu.be/wDQYh4VgYng ]

We go back to GeneXus... and in this Orders node, we can see the ordering by attraction name is automatically provided.

We right-click on “Orders” and select “Add” / “Order”.

We give this order a name, in the properties section, such as: Country.

We right-click on the node of the new order and select “Add” / “Attribute”.

We select the CountryName attribute and press F5 to see what we’re offered.

Here, it indicates that the information is being ordered by Name; that is to say, by attraction name.

If now we want to do it by Country: the results will be displayed in alphabetical order by country.



Even if there were more than one page of attractions, this sorting is made on the total number of attractions that have
been entered, and not only those that are being shown on the current page. This happens when we click on the name of
the row. This way, only the data of the current page is sorted.
We can configure the number of records to be displayed per page in a very simple way. All we have to do is open the
Pattern section of the transaction, select “Selection” and set the “Rows per page” property with the “Custom” option. A
new property called “Custom Rows” will be displayed; there we have to enter the number of records to be shown per
page.



Let’s talk about something else:
What happens if, after applying the pattern, attributes are added to or deleted from the transaction structure?

Once the Work With pattern has been applied to a transaction, a “dynamic relationship” (synchronization) is created
between the transaction structure, the applied pattern instance and the generated objects.

This means that if we add a new attribute to the transaction structure, it will be automatically shown in the pattern
instance, and it will be added in the objects generated by the pattern. For example, the object that implements the
screen with the grid displayed at runtime.

Therefore, it will be shown when the application is run [press F5]. Since we have added an attribute, we need to
reorganize.

Likewise, if an attribute is deleted from the transaction structure (let's delete AttractionAddress), it will be automatically
deleted from the pattern instance applied and will be removed from the GeneXus objects generated. Let's reorganize
once again.

Maintaining dynamism

• Example:  New attribute AttractionAddress

Applying Patterns

Structure of the 
transaction

Instance of the pattern 
applied

Objects generated by 
the pattern
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[ DEMO: https://youtu.be/d-7elSwJ5_o ]

When is this dynamic relationship lost?

For example, if we open one of the objects generated by the pattern [WWAttraction] and edit its form (we add a control
or change something; for example, delete the attraction's photo), the dynamic relationship between the instance and
the generated object is lost. That is to say, if we add the AttractionAddress attribute again to the transaction structure, it
is added to the pattern structure, but not to the generated object. Let's remove it.

The same happens if we change the events, rules, or any other section of the object generated by the pattern.

So, losing the existing dynamic relationship means that the definitions made later in the pattern instance will no longer
be applied to the generated objects, and they will have to be defined manually. For this reason, changing the objects
generated by the pattern is not recommended.

Can the dynamic relationship be recovered? Yes, by opening the object that lost this relationship in edit mode, through
the Apply Default options in the menu. Note that we can recover the dynamic relationship of the form, or of all the
object's parts (Form, events, etc).

Let's retrieve the form that the pattern builds by default.

Note that the photo is displayed again.



Maintaining dynamism

Yes, when the objects generated are edited.

Is dynamism lost?
Is it possible to recover it?

Yes, through the Edit menu:

Applying Patterns



General Settings

Full version only
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If now we want the "work with attractions" screen to no longer offer the possibility to insert a new attraction:

We open the pattern instance. Note that the Insert property is included in the Modes node properties.

As we can see, the possible values for this property are True, False and Default. As we saw at runtime, the Default value
is True.

So as not to offer the possibility to insert a new attraction from the screen, we will only have to select False. We try it by
pressing F5.
The option to insert new attractions is no longer displayed.

Where is the “Default” value of the Insert property defined? As for the values of the Update, Delete, Display, and Export
properties, what's their purpose?

Suppose that we wanted all the “work with” elements (attractions, countries, categories if we applied it, customers as
well) not to offer the possibility to make insertions. We have two options: open each transaction and in their pattern
instance change the value of the Insert property as we just did for the Attraction, or go to where this “default” value is
set and change it to False once; this will affect all the work with elements that still have “default” as their value.

In the GeneXus Trial version, that location is not accessible. In the Full version, it is in the Preferences window, below
Patterns / Work With for Web.

The values defined here are used to initialize the properties of each pattern, when the instances are created.
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Modification of properties in a specific or general instance

Example:  Not allowing the entry of countries (in its instance)



Another question that we can ask ourselves is if we can undo the application of the pattern to a transaction; that is to
say, if we can delete all the objects and features of the pattern as if it had never been applied.

To undo the application of the pattern, we must select the instance below the transaction icon and delete it.

This deletes all the generated objects and automatically clears the box “Apply this pattern on Save” in the Patterns tab
of the transaction. To apply the pattern again, we only need to check the box again and click on Save.

Deleting the pattern

Delete

Applying Patterns



Pattern Work With for Smart Devices

Applying Patterns

Here we have seen how easy it is to apply a pattern; in this case the Work With pattern... we’ve also seen the various
features that are automatically generated, as well as the options to customize them as we want, in order to adapt them
to our needs.

In this video we've seen the Work With for Web pattern, and in another video we will see how to apply the Work With
for Smart Devices pattern.
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Transaction structure Instance of the applied 
pattern

Pattern-generated 
objects

Applying the pattern to the transaction not only generates the objects that implement the new screens provided by the
pattern, but also modifies the transaction’s behavior so that it can follow this new interaction flow.
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For example, let's look at the Rules section. As we can see, it has added this whole set of rules, leaving comments to
warn the developer not to change them. Here is the Error rule that we had declared before. That one is left intact,
outside of that block of rules added by the pattern.

If we look at the first rule in the code block added by the web pattern, it's the rule that allows you to define the
parameters that the object will exchange with whoever invokes it. Something you might have noticed is that once we
apply the pattern, the transaction no longer appears in the Developer Menu. It can no longer be directly invoked for the
user to enter one attraction after another, changing some of their values, or deleting others. The reason is that the
transaction will now always be invoked by passing parameters to it, i.e. telling it in which mode it will be opened and
instantiated according to which identifier value. We will dwell on this later, when we study communication between
objects.

Likewise...
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… If we go to the events section that we haven't mentioned yet for the transactions, we see that the pattern has
incorporated quite a bit of code.



Web panels / Web components

The objects corresponding to the screens that organize and display the Work With element information are called Web
Panels (or a specialization corresponding to a little piece of a web panel, which is called web component). We will study
this object later, as we need to know how to develop our own application screens, which will be an important part of the
UI. GeneXus has implemented them for us here, but we must learn how to do it on our own.



BACK OFFICE

WEB

SMARTPHONE

TABLETS

First with transactions and now with the screens created by the Work With pattern applied to those transactions, we
can see how the back office of our application begins to take shape; that is, the specialized application to handle the
data of the other application, which we will release for the end customer. Remember that the latter are called
customer-facing applications.
In general, the back office application is only a web app, but it is not mandatory. It may also run on other types of
devices, such as phones or tablets. The solution is similar, using the other Work With pattern.



Applying the Work With pattern to the Attraction transaction:

Pressing F5:

The behavior of the Attraction transaction was modified

New objects –web panels – were created that implement the Work With screens

The Developer Menu was modified.

The Database didn’t have to be reorganized

Every new or modified object was programmed in the corresponding language and compiled, uploading 
everything to the cloud

GeneXus ran the modified Developer Menu.

If we look back at what happened when we applied the Work With pattern to Attraction:

- Some parts related to the behavior of the Attraction transaction have been modified.
- New objects have been created; in particular, web panels that implement the Work With screens.
- The Developer Menu has been modified, so as not to invoke the transaction anymore, and instead invoke the

associated Work With component. To achieve this, some more objects were modified/created, which do not matter
now.

Next, when pressing F5:
- GeneXus understood that there were no structural changes in the data, so it did not have to reorganize the database.
- Also, GeneXus programmed each new or modified object in the target language and compiled it, uploading it all to

the cloud server.
- Lastly, GeneXus ran the modified Developer Menu.



SERVER
CLIENT

(BROWSER)

FRONT END BACK END

DATABASE

Then, when the user runs WWAttraction:

The front end part of the program (that is, the part of the object that controls the User Interface, reacts to actions
performed, communicates with the server), which asks the server for the information to be displayed on the grid (all
attractions), is loaded in the client's browser. The back end part of the program requests the information from the
database, and returns it to the browser, which displays the loaded page.



Lastly, we go back to GeneXus and save the changes in GeneXus Server.

In addition, there are other patterns that generate useful functionalities and they can be viewed in this page.

Other patterns…

Applying Patterns
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